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I. Solving Geometry Problems 
with Geometry Expressions 

Geometry Expressions™ is an interactive application that lets you specify geometry 
problems with symbolic constraints — for example, set a line to have length a, set an 

angle to be θ, or make two lines perpendicular — rather than entering numeric values. 
The requested measurement is also output symbolically, as a mathematical expression. 

After you’ve read about the basic ideas underlying Geometry Expressions, try running 
the Geometry Expressions Tutorials to help you get started. 
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Constraints and Constructions: Two Ways to Work 

Use Geometry Expressions to solve problems with a straightforward three-step process: 

1. Draw geometric objects such as points, lines, or circles. You need not draw them 
exactly — Geometry Expressions will make the necessary adjustments as you work. 

2. Constrain their relationships. As you specify constraints, the drawing adjusts to 
satisfy them. You can constrain the problem fully, or you can leave some elements 
unspecified. 

3. Request a measurement. Geometry Expressions adds any missing variables 
required for the calculation, then outputs the requested expression or value. 

It’s not important to draw objects exactly at first; instead, the application corrects the 
drawing one step at a time as you define the problem by adding constraints.  This 
constraint-based approach enables a flexible, exploratory work style. It also readily 
lends itself to defining a problem symbolically, as it allows you to specify constraints — 
distances, angles, slopes, etc. — in terms of symbols.  Geometry Expressions provides 
a rich set of geometry objects and constraints, described in the User Interface 
Reference and embedded Help system.  

You may be familiar with other interactive geometry applications, such as Geometer’s 
SketchPad® or Cabri Geometry™, which use a different approach: 

1. Draw independent geometric objects.  

2. Define dependent objects using constructions. 

Geometry Expressions also enables this work style, providing a rich set of 
constructions, too (see the User Interface Reference and embedded Help system).  

A construction defines a new geometry object in terms of existing objects. A 
construction-based approach requires you to distinguish between independent and 
dependent objects, and draw the independent objects accurately from the start. The 
drawing starts out correct and remains correct at each step. To enable this, the 
approach typically requires some foreknowledge of the problem geometry. 

To compare these two approaches, we’ll use both to create a drawing that shows the 
incircle of a triangle — the circle inside the triangle that’s tangential to all three sides.   
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Constraint-based Drawing 

A constraint-based approach starts with a drawing that contains all the pertinent 
geometrical objects, but does not at first require them to be correctly related (though the 
circle should lie more or less inside the triangle to distinguish it from the excircles): 

 

All we know of the incircle is that it is tangent to all three sides of the triangle. So we 
describe the problem by applying… 

1. …the first tangency constraint: 

 

2. …the second tangency constraint: 
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3. …and the last: 

 

The drawing now accurately represents the desired situation. 

Construction-based Drawing 

By contrast, a construction-based approach builds an accurate drawing step-by-step, 
relying on previous knowledge: that the center of an incircle is the intersection of two 
angle bisectors of the triangle. 
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1. Draw the triangle: 

 

2. Construct the angle bisector of one angle. 

3. Construct the angle bisector of the second angle. 

4. Construct the intersection point D of the two angle bisectors: 
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5. Construct a line perpendicular to AC through D. Construct the point E, where the 
new line intersects AC: 

 

6. Draw a circle centered at D which passes through E: 

 

It requires some geometric foreknowledge or ingenuity to come up with this 
construction, nor is it clear without a proof that the circle is indeed tangent to sides AB 
and BC. 

Construction-based drawing is the approach used by other interactive geometry 
applications, and therefore you may be used to it. Constraint-based drawing, on the 
other hand, enables a more natural, exploratory style of problem solving. In practice, 
you’ll probably use a combination of these two approaches, making the geometry much 
easier to create. 
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How Does Geometry Expressions Solve Problems? 

You can easily use Geometry Expressions without understanding anything about its 
internal process, but for various reasons, you’ll find it helpful to understand how it builds 
the geometry problem and calculates the requested output. This understanding will 
make clear: 

• how the application uses your drawings to resolve ambiguities; 

• when and why the application adds variables; 

• why it sometimes prompts you to resolve conflicts among constraints, and how to 
resolve these when they occur.  

To shed light on these matters, we the offer following brief explanation of Geometry 
Expressions’ internal process. 

The Internal Construction Sequence 

Though it’s often natural and straightforward to describe a geometry problem in terms of 
constraints, internally, Geometry Expressions uses constructions. 

1. As you specify geometric objects and constraints, it creates a construction sequence 
for them.  

2. It executes those constructions to create a symbolic model of your geometry 
problem.  

3. It creates a drawing that includes the objects and conforms to the constraints. To do 
so, it assigns sample numeric values for the variables. 

For example, in the drawing below, AB is constrained to be length a, BC is constrained 
to be length b, AB is constrained to be perpendicular to BC, BD is constrained to be 
perpendicular to AC, and D is constrained to lie on AC. 
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Given this input, Geometry Expressions internally creates a construction sequence such 
as: 

1. Place point A at an arbitrary location, creating variables to represent the coordinates 
of point A — by default, (u0, v0). 

2. Put point B distance a from A in an arbitrary direction, creating another variable to 

represent the slope of line AB — by default, θ0. 

3. Calculate a sample value for a by measuring the distance of the line AB, using the 
native coordinate system. (Though the drawings we’ve shown so far do not show the 
axes, coordinates, or grid, you can reveal or hide them easily by clicking on the 
coordinate tool on the toolbar. See the User Interface Reference or embedded Help 
system.) 

4. Create a line perpendicular to AB through B. 

5. Put point C on this line at distance b from B.  

Two points are possible at this distance — either to the left or to the right of the line 
AB. Geometry Expressions takes its cue from where you drew the line segment and 
placed the point. If the drawing shows C to the right of AB, Geometry Expressions 
determines that’s what you intended. 

6. Find a line perpendicular to AC through B. 

7. Put D at the intersection of this line and AC. 

The existence of a construction sequence for Geometry Expressions is not equivalent to 
a problem being mathematically well defined. Unfortunately, Geometry Expressions’ 
toolbox of constructions cannot cope with a number of mathematically well defined 
problems. Nevertheless, with a little ingenuity, you can usually find an alternative way to 
describe the problem, one that the application can construct. 

Application-added variables, resolving geometrical ambiguities, and what happens 
when Geometry Expressions cannot find a construction sequence are all discussed in 
more detail below. 

Application-added Variables 

Geometry Expressions does not require you to specify your model in every detail.  The 
underlying geometry engine automatically fills in any variables you’ve left unspecified. 
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For example, the following drawing (typical of many geometry problems) constrains the 
shape of the triangle but not its location:   

 

 

Asking for the coordinates of points A and B, then, requires the system to add variables 
for the location of point A and the direction of line AB: 
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By default, Geometry Expressions creates the variables u0 and v0 for the x and y 

coordinates of point A, and θ0 for the direction of the line AB. It associates numeric 
values with these variables based on the location of the pertinent object on the 
drawing’s coordinate system. 

Geometry Expressions cannot always calculate sample values so easily. When a 
variable is used in more than one place, or when it is involved in a complicated 
expression, the application solves equations to come up with appropriate sample 
values. However, whatever values it assigns, you can always set your own values 
directly in the Variables panel (discussed below, in “Controlling Variables”, p. 28). 

Resolving Ambiguity 

Geometry Expressions uses your drawing to resolve ambiguities. For example, the 
following drawing shows two triangles, ABC and ADC. Both have two sides of 

constrained length, one of length a and the other of length b, as well as an angle θ, an 
unincluded angle: 
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Two sides and the included angle uniquely define a triangle, but two sides and an 
unincluded angle do not. So if you specify a triangle using two sides and an unincluded 
angle, it’s not unique: two possible solutions exist. In the drawing above, it could be 
either ABC or ADC.   

In ambiguous cases like this, Geometry Expressions determines which solution you 
intend according to how you drew the objects.  

Both triangles have one included angle(BAC and DAC), one unincluded yet constrained 
angle(ACB and ACD), and an unconstrained and unincluded angle (ABC and ADC). 
The key difference between the two triangles is whether this last angle is acute or 
obtuse. So the application consults your drawing to see how you drew this key angle. If 
you drew it as acute, the application constructs the triangle ABC; if you drew it as 
obtuse, it constructs ADC instead. 

A trapezoid with the constraints specified below also has two possible solutions for the 
angle ABC — one convex, the other concave. Because the drawing is convex, 
Geometry Expressions chooses the convex solution: 

 

Constraint Conflicts 

You might try to add more constraints than necessary, creating a situation in which the 
constraint you’re trying to add conflicts with existing ones. In such cases, Geometry 
Expressions cannot find a construction sequence. 
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If you enter a constraint for a geometry object that is already constrained, you’ll see a 
dialog such as this:    

 

You can resolve constraint conflicts in any of three ways: 

• Cancel the operation to leave the drawing as it was without the new constraint. 

• “Calculate [new constraint] from other constraints.” Like canceling, this choice 
eliminates the new constraint. Unlike canceling, however, Geometry Expressions 

also calculates the selected geometry's value and displays the result. 

• To add the new constraint, you must relax one of the conflicting ones. Choosing the 
bottom radio button affords the opportunity to choose which; all the conflicting 
constraints are highlighted in red, the constraint you tried to add is highlighted in 
yellow (Figure 1).   

 

Figure 1 

When you select one of these constraints (Figure 2 shows the result of clicking on θ), 
the highlight of the current constraint changes to green.  
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Figure 2 

OK adds your new constraint, then calculates and displays the new value of the variable 
associated with the relaxed constraint (Figure 3). 

 

Figure 3 

You’ll need to resolve constraints conflicts whenever you add a new constraint that is: 

• not independent of those already added; 

• not generically applicable, though possibly applicable in specific cases; or 

• for which a construction sequence cannot be derived. 
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Below is an example of a constraint that isn’t independent: three sides already define 

the triangle, so θ is dependent on the side lengths.   

 
 

To resolve this conflict, you can eliminate one of the constraints — either one of the 

problematic side lengths, or θ. 
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Below is an example of a constraint that, while it appears to be independent, would not 
be so in all cases. The line segment has been assigned the equation Y=X, and the point 
A has been assigned the coordinates (0,0). The point (0,0) does indeed lie on the line 
Y=X, but other values for its coordinates might not. For example, if you tried to constrain 
A to be at coordinates (1,0), the Y=X constraint would be violated. Constraints in 
Geometry Expressions must be applicable generically, rather than relying on specific 
values. 
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To resolve this conflict, instead of setting the equation of the line, you could set its 
slope: 

B

A

1

(0,0)

 

Some problems seem to violate neither of these rules; nevertheless, Geometry 
Expressions can’t find a construction sequence that satisfies them. For example, 
suppose you’re trying to determine the length of the side of a regular pentagon inscribed 
in a circle of radius r. You might try to draw the pentagon by constraining its sides to be 
of equal length: 
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The constraints are certainly independent, so why the prompt to resolve a conflict? The 
answer lies in the details of how Geometry Expressions converts the constraint 
description into a construction sequence.  

A construction sequence is a sequence of primitive geometrical operations, each of 
which creates a single geometric object. For example: 

Create a point on a given line, distance a from a given point. 

or: 

Create a circle tangent to three given circles. 

To draw the specified pentagon, Geometry Expressions starts with a circle of a 
particular radius. It then constructs a point on the circumference at an arbitrary location. 
Next, it must construct another point, this time one whose location is not arbitrary. But 
calculating the point's position would require simultaneously resolving all the congruent 
distance constraints. Geometry Expressions can’t resolve that many constraints at 
once; it can resolve them only in batches of two or three, with each batch defining just 
one geometrical object. So Geometry Expressions is unable to create the construction 
sequence. 
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To solve this problem, you need to try a different approach. For example, specify the 
angles from the center of the circle, which enables Geometry Expressions to construct 
the points one by one: 

D
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Calculating Output 

Geometry Expressions calculates results based on the objects as you’ve drawn them, 

and the constraints or constructions you’ve specified. If you haven't supplied all of the 
necessary constraints, the system adds any missing variables automatically. (For an 
example, see “Application-added variables”, p. 12.) 

You can ask for calculations in either numeric or symbolic terms by choosing the 
appropriate tab (Real or Symbolic) when you request the output. Symbolic calculations 
yield results as mathematical expressions. 

Geometry Expressions can present the results of its calculations in different ways, 
depending on your output settings. Two in particular require discussion —whether you 
wish to see absolute values for certain terms, and how you wish to treat intermediate 
variables. 

Eliminating Absolute Values 

Use Assumptions is a checkbox in the Output panel that determines whether 
expressions include or eliminate absolute values: the assumption in question is whether 
the operand of the absolute value is positive or negative. 

When checked, the application assumes that a given term is positive, if the value of the 
absolute value operand is positive. If it’s negative, the corresponding term is assumed 
to be negative. 

When unchecked, pertinent terms appear in expressions enclosed in absolute value 
bars. 
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For example, without assumptions, in this drawing of Paucellier’s linkage, the height of 
D depends on parameter t: 

 

If you check Use Assumptions, the expression simplifies and no longer involves t. 
However, other assumptions can sometimes be added, as shown below. Check these 
assumptions against the geometry of the diagram to see if they accurately express your 
intentions. 
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The second assumption in the drawing above is equivalent to assuming that angle AEB 
is obtuse; given the geometry of the drawing, is reasonable. 

Assumptions are a means to simplify expressions and apply only to absolute values. If 
an expression doesn’t include any terms in absolute values, the checkbox will have no 
effect. 

Using Intermediate Variables  

As described in “Calculating Output” above, the application expresses results in terms 
of: 

• variables you’ve added, and 

• additional variables the application added, if you haven’t fully specified the drawing.  

However, expressions can sometimes be so large and complex as to be difficult to read 
and understand. To make output expressions clearer and more compact, you can 
choose to use intermediate variables.  

An intermediate variable is a variable defined in the same terms — your own variables 
plus those the system added — for the purpose of simplifying an expression and 
enhancing its readability. Not every expression needs or can benefit from intermediate 
variables, but for some expressions, their use allows one straightforward name to 
replace a significant portion of the expression.  
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You can control how Geometry Expressions handles intermediate variables in three 
ways: 

• An Intermediate Variable Complexity setting determines how complex an 
intermediate variable must be before it appears in an expression. 

• A Use Intermediate Variables checkbox determines whether, above this threshold, 
they appear or not. 

• A Show Intermediate Variables checkbox affects their display. 

These three settings interact with each other to let you control the calculations that 
Geometry Expression performs and how it presents them. 

Intermediate Variable Complexity is an application setting, available from Edit > 
Settings. From the Math tab, this option allows you to set a threshold for intermediate 
variable complexity in terms of a number from 2 to 100. This number determines the 
complexity of the term to be replaced with a variable in an expression.  

A low number tells the application to replace even simple terms with intermediate 
variables, so you'll see more of these variables. A progressively higher number means 
that intermediate variables will represent progressively larger and more complex terms 
in expressions, so you'll see fewer of them.  

Use Intermediate Variables, a checkbox in the Output panel, determines whether 
intermediate variables above the complexity threshold are used or not. When checked, 
terms more complex than the threshold will be replaced by intermediate variables in 
expressions. Terms simpler than the threshold are not replaced.  

When unchecked, intermediate variables never appear and the threshold has no effect. 

Show Intermediate Variables, also a checkbox in the Output panel, determines 
whether intermediate variable definitions are displayed with results. When checked, 
you’ll see the results, including intermediate variables, followed by additional lines 
displaying the definition of each intermediate variable used.  

When unchecked, you’ll see intermediate variables in expressions according to the 
other two settings, but not their definitions.  

Show Intermediate Variables affects only how an expression is displayed; it has no 
effect on the underlying expression itself. And it’s relevant only when Use Intermediate 
Variables is checked. When Use Intermediate Variables is unchecked, there are no 
intermediate variables to display. 
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To summarize: 

• Intermediate Variable Complexity sets a threshold above which intermediate 
variables are used to calculate expressions, and appear in them. They thus affect 
the details of the expression that’s calculated, as well as affecting the expression’s 
readability. 

• Use Intermediate Variables determines whether to use intermediate variables 
above the threshold, or not. This also affects the details of expressions. 

• Show Intermediate Variables determines whether to display the definitions of 
intermediate variables when they are present. 
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Controlling Variables 

As you create geometry objects and add constraints or constructions, Geometry 
Expressions creates the required variables; assigns numeric values according to the 
constraints, constructions, and drawing; and lists any variables you create along with 
their values in the Variables panel. 

The numeric value assigned to a variable is like a sample value; it does not replace the 
symbolic value — the expression. Instead, the application uses the numeric value for 
four purposes: 

• to determine where to draw the geometric objects on the page, 

• to resolve ambiguous geometry, 

• to determine whether to substitute a positive or negative value for an absolute value 
when using assumptions, and 

• to take numeric measurements from the drawing. 

You don’t have to accept the sample values assigned by the application. You can 
control the values of variables various ways: 

• Assign a value directly. 

• Lock a variable to its current value, so that it won’t change when you drag geometry 
objects in the drawing. 

• Assign a range of values to the variable for creating an animation.  

These capabilities are discussed below. 

Assignment 

If you wish a given variable to have a specific value, you can assign it directly by 
selecting the variable in the panel and entering the desired value in the input field. (See 
the User Interface Reference or embedded Help system.) If you assign a value that 
results in a geometry that the application cannot construct, the problematic objects in 
the drawing will disappear. However, they’re not gone; they'll reappear when you set the 
variable to a value consistent with the rest of the drawing. 

Locking 

By default, when you drag points in a Geometry Expressions model, it adjusts the 
variable values to accommodate the drag as best it can. For example, in the model of a 

four-bar linkage below, dragging point B changes lengths a and b and angle θ: 
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However, you may wish the drag to act as if lines AB, BC, and CD were rigid, and only 

angle θ adjustable. To arrange this, lock all the variables except θ. 

Locking a variable applies only to its behavior when you drag the drawing. You can still 
assign it a value by entering it in the input field. 

Animation 

Geometry Expressions allows you to set a range of values to a variable, then run 
through the range to animate your drawing, using the familiar video playback interface. 
To animate a drawing: 

1. Select a variable to drive the animation. 

2. Assign a range of values to that variable. 

3. Press Play. 
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In the figure below we select θ to crank the linkage: 

 

From other interactive geometry applications, you may be familiar with animating points 
along line segments or curves. Geometry Expressions provides this animation capability 
as well, using the constraint point proportional along a curve. 

A point proportion t along a curve is defined thus: 

for:   definition: 

line segment AB  point (1-t) A + tB  

circle    point on the circle that subtends angle t at the center 

locus or envelope  point at variable value t 

 

For example, in the following drawing, D is defined proportion t along AB, and E is 
defined proportion t along BC. The curve is the locus of F as t varies between 0 and 1: 
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To animate this, we assign t the range 0 to 1, then push Play. 

The construction of both locus and envelope curves can be defined in terms of any 
variable. For example, starting with the drawing below: 

 

…we create a locus over values of t, keeping other variables constant: 
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Importing and Exporting Expressions 

You can copy expressions from Geometry Expressions and paste them into an algebra 
application such as Maple™ or Mathematica®, and you can also copy expressions from 
such applications and paste them into Geometry Expressions.   

To enable this, Geometry Expressions uses the standard MathML™ interchange format. 
MathML — Mathematical Markup Language — is an extension of the widely adopted 
XML protocol, designed for mathematics applications. 

The official MathML web page and specification is at: 

www.w3.org/Math/ 

MathML comes in two varieties: 

• Presentation MathML 

• Content MathML 

When copying from a companion application into Geometry Expressions, use Content 
MathML, which is the variety that Geometry Expressions accepts. 

As a convenience, Geometry Expressions places expressions you copy on the 
clipboard as both Presentation MathML and Content MathML. Many applications can 
accept this dual input and choose the variety they require.  

Some applications, however, might not be able to accept dual input. If you are having 
difficulty with an expression copied from Geometry Expressions: 

1. Consult the user’s guide or help system for the target application to determine which 
variety of MathML it accepts. 

2. Use Edit > Copy As… to invoke a dialog enabling you to choose between the two 
varieties. Only the one you choose is placed on the clipboard. 
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Performance Tips 

Various factors affect the simplicity and readability of the result and also, in some cases, 
the speed at which it is reached: 

• How clearly have you defined your problem? The fewer unknowns you use, the 
faster the calculation and the more likely that the resulting expression will be simple 
and clear. 

• How constrained is the problem? Fully constrained problems produce better results 
than underconstrained ones, because you control which unknowns are used. 

• Using intermediate variables makes expressions less likely to simplify, but more 
likely to produce a result. 

• For faster calculations, use lower settings of Intermediate Value Complexity.  

• Use assumptions for simpler results, if your expression has absolute values in it. But 
check the assumption to make sure it’s what you intend; if not, change the drawing 
to reflect your intention more accurately. 
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II. Geometry Expressions Tutorials 

These tutorials are provided to help you get started using Geometry Expressions. They 
refer to the ideas discussed in Solving Geometry Problems Using Geometry 
Expressions, which we recommend you read before proceeding with this tutorial. 

Documentation Conventions 

You see: It means: 

Enter  the Enter key 

Control-Z Press Control and Z at the same time. 

Enter Press Enter (This is usually done as the final step in completing some 
desired action.) 

File > New Execute the New command from the File menu. 
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Tutorial 1: Define and solve a problem. 

In this tutorial, you will: 

 explore the tools, 

 define a simple problem, 

 calculate the solution, 

 resolve a constraint conflict, and 

 add and calculate an expression. 

As you work, remember that there’s no need to draw lengths and 
angles accurately.  Just draw a sketch.  Then, as you enter 
constraints and constructions, Geometry Expressions will update 
your sketch accordingly. 

If you do happen to make a mistake, Geometry Expressions has 
multiple levels of Edit > Undo (Control-Z) and Edit > Redo 
(Control-Y) so that you can go back and forth through a sequence 
of steps. 

Explore the user interface. 

1. Start Geometry Expressions  

2. File > New 

A new blank page opens with the tool palettes on the right:  

 Draw to create geometry objects, 

 Constrain (Input) to input any constraints, 

 Construct to create common, often used, geometry objects 
and 

 Calculate (Output) to make calculations associated with 
selected geometry elements. 

Below these are palettes that provide ways to: 

 control the way expressions are calculated, 

 insert symbols, and 

 assign variable values. 

Depending on your display size, you may need to scroll to see 
them all. 

3. You can open or close each palette individually by clicking the 
arrow at the left of the palette title. In this way, you can close 
palettes that you won’t be using. These tutorials won’t be using 
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the Symbols palette, so you may close it now, if you wish. 

You can customize the user interface in various ways.   The options available in the 
View menu control zooming, scaling, axes etc. and the items in Edit > Settings, 
address other visual, text and mathematical properties. 
 

Under Math, for example, you can set the threshold for Intermediate Variable 
Complexity.  A low threshold tells the application to substitute only simple terms with 
intermediate variables.  The more complicated ones will not be substituted.  A 
progressively higher threshold results in the automatic substitution of progressively 
larger and more complex terms with intermediate variables.  

 

4. In the Draw palette, choose the line segment tool. 
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5. Starting near the bottom left of the drawing area, click and hold the mouse button 
down as you draw a line segment going upward and to the right. Now release the 
mouse button.  This will complete the drawing of a line segment.  Geometry 
Expressions places the first point at the beginning of the line (where the cursor is 
when you first press the mouse button) and the second point at the end of the line 
segment (where you released the mouse button).   Another way of drawing a line 
segment is to click over the start point and move the cursor to the position of the end 
point and click again.  (I.e. it’s not necessary to hold the mouse button down while 
positioning the cursor.) The end points are labeled A and B respectively. 

 

6. With the line segment tool still selected, move the mouse around the drawing area, 
passing over one or both of these points. Geometry Expressions tracks the location 
of the drawing cursor, snapping it to an existing geometry object when the cursor 
gets close enough. 

7. Try creating other kinds of geometry objects using some of the other drawing tools. 
When you’re ready to go on, undo them all except the line AB. 

8. Go to the Output palette. (Scroll down to find it, if it is not already visible.) This is 
where you will see a variety of options for controlling the output answers to your 
geometrical questions.  An output expression will have to be highlighted before you 
will be able to select any of the options in this palette.  For example, if the Use 
Assumptions checkbox is selected, then Geometry Expression will assume that 
symbolic lengths will be positive.  This assumption often simplifies the output. 
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Define a problem. 

To start, we’ll use the first line segment and add three more to create something like 
this:  

 

1. With the line segment tool selected, place the cursor near point B and draw three 
more line segments. (Remember, there’s no need to draw precisely.) 

To ensure that point D lies along the line AC, move the cursor near to AC until the 

line becomes selected, D will then snap to this line.   

2. Change to the selection tool and select line AB by clicking the mouse anywhere 
along its length. 

3. With one object selected, some of the tools in the Constrain (Input) palette are 
enabled. Click the Distance/Length constraint. If a tool is not available its icon will be 
grayed.  

 
 

The constraint appears, along with the default variable name of a, selected and ready to 
change. Press Enter to accept it. 

4. Select line BC and repeat the previous two steps to constrain its length to b. 

5. You’ve now added two variables to your drawing. Go to the Variables palette (scroll 
down, if necessary) to see their names and values. The values displayed in the 
Variables palette are the current values, as taken from the default coordinate 
system.  Notice that these values will change as you vary the lengths of the sides.  
Vice versa, if you select a variable and change its value in the Variables palette, the 
geometry will change accordingly. 
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6. Select the variable a in the Variables list and, in the 
input field below, round the value to the nearest 
whole number. 

7. Select both lines AB and BC. (You can select more 
than one object at a time by making the first 
selection, then holding down Shift as you make 
subsequent selections.) 

8. With two objects selected, you’ll see a different set 
of constraint tools enabled. Click the Perpendicular 
constraint to constrain the angle to 90º. ABC is now 
a right triangle. 

Notice that point C moved, not point A, though 
either could have moved to satisfy the constraint. 
When it can, Geometry Expressions moves the 
most recently added object. 

9. There’s one last constraint to add. Select both lines 
BD and AC, and constrain their angle to be perpendicular as well. 

D

B

A
C

b
a

 

Calculate output. 

Suppose you want to know the length of the line BD: 

1. Select BD. 

2. The Calculate (Output) palette offers output as both numbers — Real — and 
expressions — Symbolic. Click on Symbolic, if it’s not already in front, then click 
the length icon. 

An expression appears, showing the requested length in terms of the two variables, a 
and b. If you select this expression, you will be able to move it wherever you wish. 
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C
A

B

D

⇒

a·b

a
2
+b

2

a
b

 

The double arrow => that appears to the left of the expression indicates that the 
expression is an output that the application has calculated. 

Resolve a constraint conflict.  

With the lengths of two sides and the included angle already constrained, the triangle is 
fully defined; any new constraint you add will conflict with the existing ones. While this 
may be obvious, you may later encounter conflicts that are less obvious. This task takes 
you through the steps necessary to resolve such conflicts. 

1. Select the line AC and add a length constraint. You’ll see this dialog:  
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2. The dialog offers you three choices: 

 Discard the distance.  This will close the dialog and put you back in the position 
you were before you attempted to constrain the length of AC.. 

 Calculate the distance from other constraints.  This will change your attempt to 
constrain the length to a request for the length to be calculated for you.  

 Relax other constraints so the distance is independent. This will give you an 
opportunity to remove one of the conflicting constraints so that the one you were 
trying to impose will become an independent constraint and no longer depend on 
existing constraint. You can then choose which constraint to relax. 

3. Click the second radio button, Calculate the distance from the other constraints, and 
then click the OK button. You’ll see the expression appear with the arrow (=>) that 
indicates it’s an output.  (It may also be given a name.  This will be the case if the 
Show Name box is checked in the Output palette. 

4. Edit > Undo 

5. Try to add the new constraint again. This time, click the third radio button, Relax 
other constraints so the distance is independent. As soon as you click it, the 
conflicting constraints highlight in red and the new one in yellow: 
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6. Click on the angle at B. Its highlight changes to indicate it’s selected; the conflicting 
constraint highlights vanish, and the new one now highlights in green. 
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7. Click OK. Now the figure includes the length constraint c, while the perpendicular 
angle constraint at B is gone. 

C
A

B

D

⇒
a

2

2
+

b
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2
-

a
4

4·c
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2
·b

2

2·c
2

-
b

4

4·c
2

-
c

2

4

c

a

b

 

8. Edit > Undo again. We’re going to need that perpendicular angle later. Leave the 
drawing as it was, without length constraint c. 

Make your own expression. 

Geometry Expressions can calculate output as expressions, but you can also define 
and add your own expressions to a drawing. 

1. Select the two points A and D. 

2. Calculate the distance between them as a symbolic output. 

3. Select the expression you’ve just output. 

4. In the Output panel, check Show Name. 

To the left of the arrow, the name zn appears. (Because you may have created one 
or more of these already while exploring, we can’t predict the exact number in the 
subscript.) This is the symbol the application assigns by default as the name of the 
expression. 

5. Select the two points D and C, and repeat the previous three steps to get a second 
expression, this one named zn+1. (Subscripts increase by one each time the symbol 
they apply to is reused.) 

Using these names, you can make an expression of your own to refer to these 
distances. For example, you can calculate the ratio of the two lengths. 
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6. In the Draw palette, choose the Expression tool.  

7. Click in the drawing where you want to put the expression. The expression appears 
as a 0, selected for overwriting. To replace the zero, enter: 

z[n]/z[n+1] 

(Square brackets indicate subscripts. Replace the n and n+1 with the subscripts for 
your own named expressions.) 

8.  The expression is calculated and displayed. 

C
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B
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Tutorial 2: Create and manipulate a curve. 

This tutorial lets you try some of the more advanced features of Geometry Expressions. 
In this tutorial, you will: 

 create a locus, 

 lock a variable’s value to see the effect it has on the drawing, 

 animate the drawing by setting start and stop values for a variable,  

 calculate two kinds of equations for the locus, 

 reflect the locus in a line, and 

 compare the equations for the locus and its reflection. 

Draw a locus. 

We’re now going to re-create the old exercise of drawing an ellipse using a pencil, two 
pins, and a piece of string. 

1. Turn on the axes by clicking on the grid tool in the toolbar. 

 

2. Make two line segments, AB and BC. Points A and C are the pins, while B 
represents the pencil. 

1 2 3 4-1-2-3-4-5

1

2

3

4

-1

-2

C

B

A

 

3. Select point A. 
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4. Add an input constraint of type Coordinate to set the coordinates of the point.  

5. When the constraint highlights, enter (not forgetting the parentheses): 

(-a, 0) 

6. Select point C and constrain its coordinates to be at (a,0). 

1 2 3 4-1-2-3-4

1

2

3

4

-1

-2

CA

B

(-a,0) (a,0)

 

7. Scroll down, if necessary, to see the value of a in the Variables palette. 

 

8. Reselect A and drag it to the right a short distance. As you drag, notice: 

 A is now constrained to lie along the X axis; moving it up or down has no effect. 

 When you move A, C also moves. 
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 When you move A, the value of the associated variable, a, changes in the 
Variables list. 

9. Select the line AB and constrain its length to be distance t. 

10. Select the line BC and constrain its length to be L–t. L now represents the length of 
the string. 

1 2 3 4 5 6-1-2-3-4-5-6-7

1

2

3

4

5

6

-1

-2

-3

-4

-5

C

B

A

(a,0)

L-t

(-a,0)

t

 

11. Notice that the two new variables have appeared in the Variables list. 

 

12. Select B. 
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13.  In the Construct palette, select Locus to construct a locus through B. 

 

14. In the resulting dialog, choose t as the parameter to vary, and enter start and end 
values of 0–25, guesses that will probably produce a complete curve.  

The locus appears — half of an ellipse, above the X-axis. 

1 2 3 4 5 6-1-2-3-4-5-6-7
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L-t

(-a,0) (a,0)

 

15. Now drag B up and down, the equivalent of changing the length of the string, and 
notice how the ellipse changes. You can also drag A or C to change the position of 
the pins. 

Lock a variable. 

When you draw an ellipse this way using real pins, pencil, and string, the length of the 
string can’t change. To emulate this real-world behavior, we can lock the value of the 
variable L. 
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1. In the Variables list, select L and click the lock icon below the list. A plus sign (+) 
appears next to the locked variable in the Locked column. 

 

2.  Select points A or C and drag it. With the length of the string constant, the locus will 
change accordingly.  

Animate a variable. 

You can also animate the drawing. To do so, we can set start and stop values for the 
variable t. 

1. In the Variables list, select t. 

2. The first input field below the video playback interface specifies the start value. Enter 
1.5. 

3. The middle field specifies the number of seconds for one cycle of the animation. 
Accept the default value of 4. The input field to its right specifies the stop value. 
Enter 12. 

 
 

4.  To animate the drawing, click the Play button ( ).  

NOTE: The start and stop values that yield an interesting animation depend to some 
extent on where you’ve located objects in your drawing. Experiment to find values that 
make an interesting animation. Values that do not allow GE to create a construction 
sequence will cause objects to disappear briefly. They’ll reappear when values make 
sense again, or when the animation stops. 
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Calculate parametric and implicit equations. 

1. Select the locus. In the Calculate (Output) palette, chose Parametric equation. The 
resulting expressions are the formulas for x and y as a function of t. Move the 
expression wherever you wish on the drawing. 

2.  Select the locus again and, this time, request the Implicit equation. The resulting 
expression gives the equation of the curve in terms of x and y. 

Make the locus reflection. 

1. Select the line segment tool again and make a line from A to C. This line lies on the 
X-axis. 

2. Select the curve. 

3. In the Construct palette, choose Reflection. The status bar now shows a message 
prompting you to choose the axis about which to reflect the curve.  

 

4. Select the line segment AC.  This will reflect the curve about the X-axis. 
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B is also reflected, its reflection appearing on the lower curve as B’. 

5. Select B and drag it; B’ follows. But, though you can select B’, you can’t drag it; it’s 
locked as the reflection of B.  

Compare locus and reflection equations. 

1. Select the reflected curve and request its parametric equation (from the Calculate 
(Output) palette).  

2. Compare them side-by-side and you’ll see that the x-parameterizations are the same 
and the y-parameterizations differ only in sign (which is, of course, as it should be). 

3. If you repeat the experiment for the implicit equation, you’ll see they are identical. 

Explore on your own. 

Having completed the introductory tutorials, we hope you’ll be comfortable exploring on 
your own. If you wish, further interesting examples can be found on our website, 
www.geometryexpressions.com. 
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III. Examples 

We present a few worked examples using Geometry Expressions.  Corresponding 
example files are installed with Geometry Expressions in the Examples folder. 

Many more examples are available at the web site:   

www.GeometryExpressions.com 
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Example 1: Circumcircle Radius 

Measure the area of a triangle with sides length a,b,c, and measure the radius of the 
circumcircle.   

 

What is their relationship? 

If a triangle is defined in terms of two sides and the included angle, what is its area? 
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Hence you can derive a formula for the radius of the circumcircle which involves an 
angle: 
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Example 2: Radius of arc offset from line segment 

Imagine a piece of drawing software where the user creates an arc by dragging the 
center of a line segment perpendicular to the segment.  The software author might want 
a formula for the radius of the arc given the length of the segment and the distance the 
user has dragged the center away from the segment. 
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Example 3: Length of the Angle Bisector of a triangle 

Given a triangle with side lengths a,b,c, what is the length of a perpendicular bisector? 
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Example 4: A Family of Circles 

We look at the family generated by two circles of radius a and b inside a circle of radius 
a+b: 

 

Clearly the radius of the nth circle is: 

222

)(

baban

baab

++

+
 

Can you prove this? 
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Example 5: Circle of Apollonius 

The Circle of Apollonius is the locus of points the ratio of whose distance from a pair of 
fixed points is constant: 

 

How do we know this is a circle? 

What is the center and radius? 

You can always get Geometry Expressions to tell you: draw a circle and set its equation 
to be the same as the locus equation (copy and paste works fine).  You can then read 
off the center and radius. 
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Example 6: Caustics in a cup of coffee 

The Nephroid curve generated by reflecting a set of parallel rays in a circle, and then 
taking the envelope of the reflected rays. 

(An envelope is created in Geometry Expressions as the locus of a line or line 
segment). 

 

This curve is the caustic which you’d observe if you shone a light obliquely into a cup of 
coffee. 
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Example 7: Two Quadratic Splines 

In the diagram below, D and E are located at proportion t along AB and BC respectively.  
F is the intersection of AE and CD.  G is the point proportion t along the line DE.  We 
examine the loci of F and G as t varies from 0 to 1.   

Observing the parametric form of the curves we see that one is a parametric quadratic, 
while the other is a rational quadratic.  Implicit forms are both conics (and almost, but 
not quite, identical). 
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What types of conics are they?  Extending the curves a little can give a clue: 

 

The upper curve looks like a parabola, the lower certainly does not. 

Can you show this is generally true from the algebraic equations of the curves? 
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IV. User Interface Reference 

Need Help? 

There are many ways to get help with Geometry Expressions.   

Your installation comes with Geometry Expressions Manual, in PDF format suitable for 
creating a hard copy.  The manual contains these sections: 

♦ Solving Geometry Problems with Geometry Expressions – a detailed 
explanation of the basic concepts. 

♦ Geometry Expressions Tutorials - step by step instructions. 

♦ Examples - several examples chosen to illustrate the power and features of 
the software. 

♦ Reference - a copy of the embedded Help system. 

 

In both the printed manual and the embedded Help system you can: 

• Use the table of contents to get details on using a tool, an icon or a menu. 

• Use the index for help on a particular topic, such as "parametric equations". 

 

Inside the Geometry Expressions Help system you can: 

• Use the search tool to find all topics based on a key word, such as "constraints". 

• Browse through help with the up "Previous page" and down "Next Page" arrows 

   . This will step you through the help sub-topics in a logical sequence. 

• You can click on colored text to get more information. 
 

Tool Tips: 

When you move the cursor over any icon on the screen, the name of the icon appears 
briefly below the cursor. 
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The Display and How It's Organized 

Many of the menu items in the drop-down menus at the top of the screen correspond to 
one of the icons or buttons across the top or down the side of the display window. 

Icons across the top of the screen comprise the standard Windows File, Edit, View and 
Help commands.  The construction and calculation tools are displayed along the side of 
the drawing window.  These toolboxes can be displayed on the left or right side of the 
window, or hidden.  

The Output window can be displayed below the drawing window to show large 
expressions. 

The status bar at the bottom of the window displays the following (from left to right): 

<Menu Help> <Current Mode> <Cursor Coordinates> <Angle Mode> 

 

The Status Bar 

The status bar at the bottom of the screen prompts the following information (from left to 
right): 

• Menu Help – summary of a selected menu item. 
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• Current Mode – Each icon in the drawing toolbox represents a mode.  Tools 
requiring additional inputs after clicking the tool will display further prompts in this 
field. 

• Cursor Coordinates – Displays the current coordinates of the cursor in the 
diagram. 

• Angle Mode – Displays the current angle units used (degrees or radians).  This 
can be set in the Edit / Settings / Math window. 

Customizing Your Display 

You can arrange the display as it suits you.  

• Use View / Tools to place the Tools panel on the Left or Right side of the 
window. 

• Use the arrow on the upper left side of individual toolboxes to show or hide them. 

• Click the pushpin on the upper right side of individual toolboxes to make it a 
"floating" box that you can drag anyplace on the screen.  

In the image below you can see other buttons which control the display. 
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File Handling 

Geometry Expressions uses standard Windows file Open and Save operations.  Save 
your files regularly with the handy  icon at the top of the screen.  

The data files generated from your drawings will have the extension ".gx".  You may 
create multiple data files and have them open in a session.  Each file is on separate 
page with the tabs across the top of the drawing window.  Click the tab to view the file.   
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Working with Algebra Systems 

All mathematical expressions in Geometry Expressions are written in MathML, so you 
can copy and paste directly to or from any other MathML program.   

Usually the standard Edit > Copy or control-C command should work.  If this doesn’t 
give you the desired result, try the Edit > Copy As command.  Select from the submenu 
of choices appropriate to your application. 

In this section, we describe how to copy mathematics from Geometry Expressions into 
an algebra system, and from an algebra system into Geometry Expressions. 

We describe how to do this generically using MathML.  We also describe specifically 
how to share information with Maple and Mathematica. 

MathML 

There are 3 different ways to export expressions as MathML from Geometry 
Expressions: 

In each method, you must first select the measurement to be output.  Then either: 

Copy copies the expression as both content and presentation MathML 

Copy As > Content MathML copies the expression as Content MathML only. 

Copy As > Presentation MathML copies the expression as Presentation MathML only. 

Depending on the destination application one of these methods may work better than 
the others. 

On import, Geometry Expressions is looking for expressions in Content MathML form.   
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Special forms of expression 

There are a couple of special cases to note: 

• An expression with assumptions is turned into a list, with the main expression as 
the head of the list, and the assumptions following. 

For example: 

 

Becomes 

r - s  r + s , 0 < r - s, 0 < 2 r - 2 s[ ]
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• An expression with intermediate variables is converted into a list, with the main 
expression as the head of the list and the intermediate variable definitions 
following. 

 

Becomes: 

 

Working with Maple 

Geometry Expressions gives the option of exporting expressions in Maple Input format:  
use 

Copy As > Maple Input 

This is the most reliable way of transferring expressions directly into Maple.   

When you are using this option, expressions copy in quite a different form when 
intermediate variables are present and when they are not present.  When intermediate 
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variables are present the expression copies as a Maple function, where intermediate 
variables are locals to the function.  When intermediate variables are not present, a 
single Maple expression is created: 

For example: 

 

Becomes: 

proc a, b, c( )

local d_1, v_1, phi_0, d_3;

d_1 := -a + b + c( )^ 1/2( )* a - b + c( )^ 1/2( )* a + b - c( )^ 1/2( )* a + b + c( )^ 1/2( );

v_1 := - /d_1( ) 2*a( );

phi_0 := /-a - b - c( )*v_1( ) c*b( );

d_3 := /v_1*a( ) b( );

/v_1*d_3( ) phi_0*c( );

end proc;
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Whereas  

 

Becomes 

-a + b + c  a - b + c  a + b - c

2 a + b + c
 

Working with Mathematica 

Geometry Expressions gives the option of exporting expressions in Mathematica Input 
format:  use 

Copy As > Mathematica Input 

This is the most reliable way of transferring expressions directly into Mathematica.   

When you are using this option, expressions copy in quite a different form when 
intermediate variables are present and when they are not present.  When intermediate 
variables are present the expression copies as a Mathematica Module, where 
intermediate variables are locals to the module.  When intermediate variables are not 
present, a single Mathematica expression is created: 
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For example, 

 

Copies as: 

Module[{d$$1,v$$1,ϕ$$0},d$$1=((((a*(-1))+b+c))^(1/2)*((a+(b*(-
1))+c))^(1/2)*((a+b+(c*(-
1))))^(1/2)*((a+b+c))^(1/2));v$$1=(d$$1*(a)^((-1))*(-
1/2));ϕ$$0=(((a*(-1))+(b*(-1))+(c*(-1)))*v$$1*(c)^((-1))*(b)^((-
1)));((ϕ$$0)^((-1))*(v$$1)^(2)*(c)^((-1))*(b)^((-1))*a)] 

−

è!! !! !! !! !! !! !!!
a +b − c

è!!!! !! !! !! !! !!!
a − b +c

è!!!!! !! !! !! !! !! !!
−a + b+ c

è!!! !! !! !! !! !! !!
a + b + c

2 H−a − b − cL  
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While: 

 

Becomes: 

((((a*(-1))+b+c))^(1/2)*((a+(b*(-1))+c))^(1/2)*((a+b+(c*(-
1))))^(1/2)*((a+b+c))^((-1/2))*1/2) 

 

è!!!! !! !! !! !! !!!
a + b −c

è!!!!! !! !! !! !! !!
a − b + c

è!!!!! !! !! !! !! !! !!
−a + b + c

2
è!! !! !! !! !! !! !!!
a + b +c  

When you copy an expression as a module, you can work with the module numerically 
in Mathematica (by compiling it) without ever having to do a complete symbolic 
evaluation.  This can be a useful feature when dealing with complicated expressions. 
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Copying from Mathematica into Geometry Expressions  

In order to get Mathematica to create Content MathML, in a form suitable for Geometry 
Expressions, you should execute the following commands: 

SetOptions[XML`MathML`ExpressionToMathML, "NamespacePrefixes" > {}, 
"Formats" > {"ContentMathML"}]  

SetOptions[XML`MathML`BoxesToMathML, "NamespacePrefixes" > {}, 
"Formats" > {"ContentMathML"}] 

SetOptions[Export, ConversionOptions > {"NamespacePrefixes" > {}, 
"Formats" > {"ContentMathML"}}] 

SetOptions[ExportString, ConversionOptions > {"NamespacePrefixes" > {}, 
"Formats" > {"ContentMathML"}}] 
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Drawing Tools 

 
 

The Draw toolbox contains the drawing modes and the Selection Arrow.  The drawing 
modes can also be invoked from the Draw menu.  Once selected, a mode is active until 
you change to a different one.  You can find the active mode by noting which button is 
pressed or looking at the mode area in the status bar. 

Links to the drawing modes are detailed below: 

 

Point  

 

Line 
Segment  

 

Infinite Line  

 

 

Vector  

 

Polygon  

 

Circle  

 

Text  
 

Expression  

Add a Point 

 
 

To insert a point in your drawing, follow these steps: 

1. Click the Point icon  in the Drawing toolbox or select Point from the Draw 
menu. 

2. Move the crosshairs  into position.  

3. Click the mouse to place the point under the crosshair. When the crosshairs are 
positioned over some geometry an incidence symbol (bowtie) is displayed around 
the point and the geometry is highlighted.   A click of the mouse will create the 
point incident to the geometry.  
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The Line Segment Tool 

 
 

To add line segments to your geometry follow these steps: 

1. Click on the Line Segment icon  in the Draw toolbox or select Line Segment 
from the Draw menu. 

2. Position the cursor in the drawing window. 

3. Click the mouse to place each endpoint. 

Each line segment is displayed with a letter label for each endpoint.  

 

You can change the label from the Select mode . 

To abort a line segment in the middle of the drawing operation, hit the "esc" key.    

Drawing Lines 

 
 

Lines are similar to line segments except they have infinite length. 

1. Click the Infinite Line icon  in the Draw toolbox or select Infinite Line from 
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the Draw menu. 

2. Position the line cursor in the drawing window. 

3. Click the cursor to anchor the line at the cursor position.  The anchor point will be 
displayed on the line. 

 
4. Move the cursor in the drawing window to position the line and click the cursor 

when you get the line in the desired orientation. 
 

Lines are infinite and do not have points associated with them unless you specifically 
place one on the line. 

Drawing Vectors 

 
 

To add vectors to your geometry follow these steps: 

1. Click the Vector icon  in the Draw toolbox or select Vector from the Draw 
menu. 

2. Position the cursor in the drawing window. 

3. Click the mouse to place each endpoint. 

Each vector is displayed with a letter label for each endpoint. 

Drawing vectors is similar to drawing line segments, but vectors are constrained with 
coefficients of the form:  
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The Polygon Tool 

 
 

You can quickly create a multi-sided figure with these steps: 

1. Click the Polygon icon  in the Draw toolbox or select Polygon from the Draw 
menu. 

2. Position the cursor in the drawing window.   

3. Move the cursor and click once to place each vertex.   

• As you create the sides of the polygon, each vertex is automatically assigned a 

letter name.  You can change the label in Select  mode.   

• When you create the last side of the polygon by clicking on the first vertex, the 
polygon will be filled.   

• To change the appearance of the polygon, select  it and click the Geometry tab 
in the Edit / Settings menu. 

Drawing Circles 

 
 

To add a circle to your diagram, follow these steps: 

1. Click the Circle icon  in the Draw toolbox or select Circle from the Draw 
menu. 

2. Move the cursor in the drawing window to the position of the center of the circle 
and click once.   

3. Move the cursor to draw the circle in the desired size and click again.  
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Notice the circle is displayed with 2 points, the center and a point on the perimeter.   

 

You can adjust the circle in Select  mode.    

Adding Text to the Drawing 

 
 

To add titles or other annotation to the drawing follow these steps: 

1. From the Draw toolbox click the Text icon  or select Text from the Draw 
menu. 

2. Position the text cursor  at the upper left corner where you would like your 
window of text located. 

3. Click and drag to form your text box. 

4. Enter and format your text in the Edit Text dialog. 

Inserting and Editing Text 

In the Edit Text dialog  you can enter and format the text that will be displayed in your 
defined text window. 
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Adding Expressions to the Drawing 

 
 

You can type an algebraic expression in the drawing window and Geometry 
Expressions will solve it with whatever information it has available. Here are the steps: 

1. From the Draw toolbox click the Expression icon  or select Expression from 
the Draw menu. 

2. Move the expression cursor  to the position where you want it to appear in the 
drawing window and click to display the data entry box. 

3. Enter the expression using numbers, variables, and output expression names.  
Use the Symbols toolbox to help you enter mathematics. 

 

Adding an expression to the diagram can help you work out relationships in the 
geometry.  Here is an example making use of the Expression tool to see the 
relationship between similar triangles. 
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Sides a and b are perpendicular, and AC is perpendicular to BD.  We obtained the 
Output of lengths AD and BD using the Show Name button.   

The expression to solve is the relationship of the two lengths:  z0 / z1.  The system 
immediately tells us => a/b.   

The Selection Arrow 

 

When you are finished with the drawing functions, click the selection arrow  to enable 
other functions or adjust your drawing. 

You must first select elements of the drawing in order to enter constraints and 
constructions and to output calculations. 

Many of the tools require you to select multiple objects. 

The Selection arrow is also available form the icon bar at the top of the screen. 
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Selecting Multiple Objects 

Many of the Constrain, Construct, and Calculate tools require that you select more 
than one object.   

To select more than one object: 

♦ Click the selection arrow   on the tool bar. 

♦ Hold down the CTRL or SHIFT key as you click the objects you want to 
select. 

If you click the wrong object while holding down the CTRL key, click it again and it will 
become unselected. 

 

If all of the objects you wish to select fall within a rectangular region, you can use the 
selection box: 

♦ Click on the selection arrow  on the tool bar or the Drawing toolbox. 

♦ Draw a rectangle around all of the objects by clicking and dragging. 

Adjusting the Drawing 

Click the Select arrow , either from the Drawing toolbox or the icon bar, to move, 
rotate or delete selected object(s) in the drawing. 

You can also change a constraint value or label by double clicking it, retyping the value 
or variable and then pressing the enter key. 
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Drawing Constraints and How to Use Them 

 
 

After sketching the geometry of a problem, constrain it with measurements, coordinates 
and implicit equations in real or symbolic terms.  The drawing responds automatically to 
the assigned input constraints.  Geometry Expressions will automatically add any 
constraints you leave out. 

Initially, all the constraints in the toolbox are inactive.  You must first select the parts for 
your drawing that will be constrained. Constraint choices are listed below along with the 
drawing elements that must be preselected.  Be careful when selecting geometry 
objects, if extra things are selected that are not related to the constraint (like other 
constraints) the constraints will remain inactive.  This can happen by mistake, especially 
when using the selection box tool. 

  

 Constraint Preselected Objects 

 Distance / Length  Two of any combination of points, lines, line segments, 
vectors, or polygon sides. 

 Radius  A circle 

 
Perpendicular  Two of any - lines, segments, vectors, or polygon sides. 

 Angle  Two of any - lines, segments, vectors, or polygon sides. 

 Direction  A line, segment, vector, or polygon side. 

 Slope  A line, segment, vector, or polygon side. 

 Coordinate  A point 

 Coefficients  A vector 

 Tangent  - A circle or locus and a line, segment, vector, or polygon 
side. 

- Or 2 circles 

 Incident  A point and a line, segment, vector, polygon side, circle or 
locus. 

 Congruent  Two or three of any line segment, vector, or polygon side. 

 Parallel  Two or three of any line segment, vector, or polygon side. 
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 Implicit Equation  A circle, line, segment, vector, or polygon side. 

 Point Proportional 
Along Curve  

A point and a line, segment, vector, polygon side, or locus  

 

Occasionally you may try to add too many constraints to the geometry, causing a 
conflict.  The system will help you correct this problem in the Resolve Constraint Conflict 
dialog. 

System Added Constraints 

In Geometry Expressions, you do not need to fully constrain your model.  Any 
parameters you have left unconstrained are filled in by the geometry engine. 

For example, the following drawing is constrained only modulo a rigid transformation 
(typical for many geometry problems).   

 
So if you ask for the coordinates of any of the points, they will be given in terms of 
system-added variables: 
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Clearly the system has added variables for the location of point A, and for the direction 
of line AB. 

Changing a Constraint 

To change a constraint, double click it with the selection arrow,   retype the value or 
variable and press the enter key. 

 

Constraint Conflicts 

If you enter a constraint for some geometry which is already constrained by another 
constrained object you will see a message like the one below.    

 
 

In this case, the Coordinate constraint was already determined by the other two sides 
and an angle constraint on the triangle.  There are three ways of dealing with this 
problem: 

Hit the Cancel button to leave the drawing as it was without the new constraint. 

Click the first button, "Calculate the coordinates from other constraints" (the default 
choice).  This is similar to the first choice, it eliminates the new constraint, but also 

calculates the selected geometry’s value.  In this case, the coordinates of point C would 
be calculated and displayed. 

If you choose "Relax other constraints so the coordinate is independent", this will keep 
the new constraint you just entered and allow you to eliminate one of the red highlighted 
constraints (figure 1).  When you select one of these constraints (in figure 2 below we 
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clicked on θ), the highlight changes to gray.  After you click Ok, the selected constraint, 

the angle θ in this case, is calculated and displayed (figure 3). 

 

Figure 1 

  

 

Figure 2 

 

Figure 3 
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Distance / Length Constraint 

 
 

The Distance / Length constraint lets you specify the following dimensions: 

• Length of a line segment, vector, or polygon side 

• Distance between two points or a point and any one of the line types listed 
above. 

To enter a constraint: 

• Select  the appropriate drawing object(s).  When you make your selection, the 

Distance / Length icon will light up  .  

• Click the icon, enter the constraint value, either real or symbolic, and press enter.  

You can press enter without typing a value to accept the system’s default value.  
 

You can click the constraint and drag it to adjust its placement on the drawing. 

Radius Constraint 

 
 

To specify the radius of a circle: 

1. Make sure you’re in select mode  and click the circle.  The circle will be 

highlighted as well as the icon  . 

2. Click the Radius icon, enter the constraint value, either real or symbolic, and press 
enter.  You can press enter without typing a value to let the system insert a 
variable name. 

3. You can click the constraint and drag it to adjust its placement on the drawing. 
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Perpendicular Constraint 

 
 

Any two of lines, segments, vectors or polygon sides can be constrained to be 
perpendicular with these steps: 

1. Select  two from the line types listed above. 

2. Click the Perpendicular icon  .   

 

The lines are redrawn and the perpendicular constraint is attached. 

Angle Constraint 

 
 

Any two of lines, segments, vectors or polygon sides can be constrained with an angle 
value or variable name with these steps: 

1. Select  two from the line types listed above. 

2. Click the Angle icon  . 

3. Enter the constraint, real or symbolic. If you enter a real value, the lines will be 
adjusted to reflect the constraint.   

Note:  The angular units are displayed in the lower right of the screen.  Change the 
default (Degrees or Radians) in the Edit / Settings menu. 

Direction Constraint 
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Constrain any of the line types; line, line segment, vector, or polygon side, to a direction 
measured from the horizontal. 

1. Select  one of the line types listed above. 

2. Click the Direction icon  . 

3. Enter the constraint, real or symbolic. If you enter a real value, the line will be 
adjusted to reflect the constraint.   

Note:  The angular units are displayed in the lower right of the screen.  Change the 
default (Degrees or Radians) in the Edit / Settings menu. 

Slope Constraint 

 
 

Specify a slope for any of the line types; line, line segment, vector, or polygon side. 

1. Select  one of the line types listed above. 

2. Click the Slope icon  . 

3. Enter the constraint, real or symbolic. If you enter a real value, the line will be 
adjusted to reflect the constraint.   

Coordinate Constraint 

 
 

You can give coordinates to any point in your drawing: 

1. Select  a point. 

2. Click the Coordinate icon . 

3. Enter the constraint, real or symbolic. If you enter a real value, the line will be 
adjusted to reflect the constraint, even if the coordinate axes are not displayed. 
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To change the coordinates shown, double click and type over the highlighted value in 
the data entry box. 

Constraining Vector Coefficients 

 
 

You can specify coefficients for a vector with the following steps: 

1. Select  a vector. 

2. Click the coefficients icon . 

3. Enter the coefficients separated by a comma. 

Note: Don’t forget the parentheses or an error message appears. 

Tangent Constraint 

 
 

Any of the line types; line, line segment, vector, or polygon side can be made tangent to 
a circle or locus with these steps: 

1. Select  a line of the types listed above and the circle or locus. 

2. Click the Tangent icon  from the Constrain tool box or select Tangent from 
the Constrain menu. 

 

The line and curve immediately become tangent. 

You can select 2 circles and make them tangent. 
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Incident Constraint 

 
 

Constrain a point to be incident to any other geometry; line, segment, vector, polygon 
side, circle or locus with these steps: 

1. Select  the point and the other geometry listed above. 

2. Click the Incident icon  from the Constrain toolbox, or select Incident from the 
Constrain menu. 

 

The point is moved to meet the line or curve, or the extension of the line. 

Below is an example of the latter, point D is moved to lie on the extension of line 
segment AB. 

 
 

If you select the point or the line, incidence is indicated by a bowtie around the point: 

 

Congruent Constraint 
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Constrain two or three of any of these geometry types: line segments, vectors, or 
polygon sides, to be congruent with these steps: 

1. Select  two line segments. 

2. Click the Congruent icon  from the Constrain toolbox, or select Congruent 
from the Constrain menu. 

 

You will see matching congruency lines on the selected segments and a length will be 
adjusted.  

 

Parallel Constraint 

 
 

Any two or three of the linear geometry types can be made parallel - line, segment, 
vector, or polygon side.   

1. Select  two from the types listed above. 

2. Click the Parallel icon  from the Constrain toolbox, or select Parallel from the 
Constrain menu. 

The geometry will be adjusted and matching symbols  appear on the 
selected lines. 

Implicit Equation Constraint 
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You can use symbolic variables to constrain geometry with an implicit equation.  Lines, 
line segments, polygon sides, vectors and circles can all be constrained with implicit 
equations. 

1. Select  the geometry. 

2. Click the Implicit Equation icon  from the Constrain toolbox, or select Implicit 
Equation from the Constrain menu. 

 

An input window will open next to the geometry you selected.  Highlighted in the window 
is a generic equation for the selected object; for a line, an equation like – XA1+YB1+C1 
= 0 might appear.  You can edit the equation with different variable names or 
coefficients as you like.  You will find these variables added to the variable list in the 
Variables toolbox.  

Constraining a Point Proportionally Along a Curve 

 
 

A point proportion t along a curve is defined variously for different types of curves as 
follows: 

• For a line segment AB, it defines the point (1-t) A + tB  

• For a circle it defines the point on the circle which subtends angle t at the center. 

• For a locus or envelope, it defines the point at parameter value t. 

1. Select  a point and one of the curves mentioned above. 

2. Click the Point Proportional… icon  from the Constrain toolbox, or select 
Point Proportional… from the Constrain menu. 

3. Enter the parameter or quantity (symbolic or real) in the data entry box. 
 

For example, in the following diagram, D is defined proportion t along AB, and E is 
defined proportion t along BC.  The curve is the locus of F as t varies between 0 and 1. 
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In the following example, the curve is the locus of the point (x, x2).  Tangents are 
created at points with parameter values x0 and x1 on this curve. 
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Creating Constructions 

 
 

After sketching and constraining your drawing there are a whole set of constructions 
that can be applied to the geometry.  First you must select the geometry elements which 
pertain to the construction.  When you select the geometry the appropriate 
constructions will be highlighted.   

The following table lists the Constructions, their icons, and which elements must be 
preselected to activate the constructions.  Be careful when selecting geometry objects, 
if extra things are selected that are not related to the construction, the construction 
icons will remain inactive.  This can happen by mistake, especially when using the 
selection box tool. 

 Construction Preselected Objects 

 Midpoint  A line segment, vector, polygon side, or 2 points. 

 Intersection  Two of:  a line, segment, vector, or polygon side. 

 Perpendicular 
Bisector  

A line segment, vector, polygon side, or 2 points. 

 Angle Bisector  Two of:  a line, segment, vector, or polygon side. 

 Parallel  A point and one of:  a line, segment, vector, or polygon 
side. 

 Perpendicular  A point and one of:  a line, segment, vector, or polygon 
side. 

 Tangent  A circle or constructed locus 

 Polygon  - Three points or 

- Three or more line segments connected to form a 
polygon.  

 Reflection  One or more objects 

 Translation  One or more objects 

 Rotation  One or more objects 

 Dilation  One or more objects 

 Locus  A point that will vary with a parameter  
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Constructing a Midpoint  

 
 

You can construct a midpoint on any line segment, vector, polygon side, or between two 
points by: 

1. Select  two points or one of the line types listed above. 

2. Click the Midpoint tool , or select Midpoint from the Construct menu. 
 

A point will appear in the middle of the selected line or 2 selected points. 

Intersections 

 
You can construct a point of intersection between any of the line types in your 
geometry;  line, segment, vector, polygon side or circle.   

1. Select  two from the line types listed above. 

2. Click the Intersection tool  or select Intersection from the Construct menu. 

A new point and label will appear at the intersection.  If the lines are segments that do 
not intersect, a point will be created at the extension of the lines as with line segments 
AB and CD below.   
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If the geometry will never intersect, the selected objects are moved to form the 
intersection. In the example below, the infinite line and circle become tangent at the 
newly created point, H. 

 

           
 

Perpendicular Bisector 

 
 

You can construct a perpendicular bisector on any line segment, vector, or polygon side 
with these steps: 

1. Select  any of the line types listed above. 

2. Click the Perpendicular Bisector tool  or select Perpendicular Bisector from 
the Construct menu. 

An infinite line will appear at right angles to the selected line. 

You can also construct a perpendicular bisector by selecting 2 points. 

Angle Bisector 

 
 

You can bisect the angle between any combination of line types; line, segment, vector, 
or polygon side with these steps:   
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1. Select  two of any of the line types listed above. 

2. Click the Angle Bisector tool  or select Angle Bisector from the Construct 
menu. 

An infinite line will appear between the two selected lines.  You can use the Calculate / 
Angle tool to get the value of the bisected angle.  

Parallel Constructions 

 
 

You can construct a line, through a point, and parallel to another line, segment, polygon 
side or vector with these steps: 

1. Select  a point and a line of one of the types listed above. 

2. Click the Parallel tool  or select Parallel from the Construct menu. 
 

A line is constructed which is parallel to the selected line and passes through the 
selected point  

Perpendicular Constructions 

 
 

You can construct a line, through a point, which is perpendicular to another line, 
segment, polygon side or vector with these steps: 

1. Select  a point and a line of one of the types listed above. 

2. Click the Perpendicular tool  or select Perpendicular from the Construct 
menu. 

 

A line is constructed which is perpendicular to the selected line and passes through the 
selected point  
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Tangents 

 
 

You can construct a line that is tangent to a circle or locus with these steps: 

1. Select  the circle or locus.   

2. Click the Tangent tool  or select Tangent from the Construct menu. 
 

A line tangent to the selected curve will appear at the point where you selected the 
circle or curve. 

Polygon Construction 

 
 

If you created a polygon with the line segment tool, or your polygon was not shaded for 
some reason, (e.g. the drawing of the sides was interrupted or out of order) you can 
make joined line segments into a polygon that can be selected with a single click using 
this construction. 

1. Select  the line segments that make up the polygon or three points. 

2. Click the Polygon tool  in the Construct toolbox, or select Polygon from the 
Construct menu. 

 

The polygon will be filled and you can now select the entire polygon with a single click. 

Reflection 
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You can reflect any subset of your diagram about a line with these steps: 

1. Select   one or more geometry objects to reflect. 

2. Click the Reflection tool  in the Construct toolbox, or select Reflection from 
the Construct menu. 

3. Either click the cursor to place the reflection line on the screen, adjust the angle 
and click again, or select an existing line as the reflection line. 

 

A copy of your selected geometry will appear on the other side of the reflection line.   

Notice all points on the reflected geometry are written as "prime", i.e. A becomes A’.  If 

you reflect the geometry again, A’ becomes A". 

Translation 

 
 

You can translate any subset of your diagram with a translation vector.  Here are the 
steps: 

1. Select  the geometry to be translated. 

2. Click the Translation tool in the Construct toolbox, or select Translation from 
the Construct menu. 

3. Click the cursor to draw the end point of your translation vector and move the 
cursor to establish the length and angle of the translation.  Click again to finish 
the vector. 

 

The translated geometry appears.  You can adjust the position of the translation by 
clicking and dragging the tip of the vector. 

Notice all points on the translated geometry are written as "prime", i.e. A becomes A'.  If 
you translate this geometry again, A' becomes A". 

Rotation 
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You can rotate any subset of your diagram about a point.  Here are the steps: 

1. Select  the geometry to be rotated. 

2. Click the Rotation tool in the Construct toolbox, or select Rotation from the 
Construct menu. 

3. Click the screen to place your rotation point. 

4. In the data entry box presented, enter the angle of rotation. 
 

The rotation of the selected geometry appears. 

Notice all points on the rotated geometry are written as "prime", i.e. A becomes A’.  If 

you rotate this geometry again, A’ becomes A". 

Dilation 

 
 

You can dilate any subset of your diagram from a point.  Here are the steps: 

1. Select  the geometry to be dilated. 

2. Click the Dilation tool in the Construct toolbox, or select Dilation from the 
Construct menu. 

3. Click the screen to place your dilation point. 

4. In the data entry box presented, enter the dilation factor. 
 

The dilated geometry appears. 

Notice all points on the dilated geometry are written as "prime", i.e. A becomes A’.  If 

you dilate this geometry again, A’ becomes A". 

Locus of Points / Envelope 
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You can construct a locus of points or envelope from a selected point or line, by defining 
a range for some constraint in the drawing.  Just follow these easy steps: 

1. Select  the point on the drawing that will form the locus (point B in the example 
below); select a line, line segment, or vector to form an envelope.   

2. When you click the Locus icon  , the Edit Locus dialog pops up.   

 
 

3. Simply fill in the values for the appropriate variable.  Click the arrow key to the 
right of the Parametric Variable window to select from a list of all variables in the 
drawing.  (If you entered the constraint in real terms, change it to a variable by 
double-clicking the constraint.) 

 

 
 

4. Click the Ok button and the locus will appear. 

 
! Note:  The locus only works if the figure’s position is fixed - i.e. a point in a triangle will 
not work as a locus unless the locations of the other two points are fixed with coordinate 
constraints. 
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The following example shows an envelope of the line DE.  We use the Point 
proportional along curve constraint and the parameter t to position the points D and E 
(D is (1-t) along line AC and E is t along line AB).  In the Edit Locus dialog, we create 
the envelope from parameter t as it ranges from 0 to 1. 

 
 

You can replay the creation of the envelope with the Animation tools.  Select variable t 
and click the Play button. 

 



Geometry Expressions Manual 

— page 104 — 

Output Calculations 

  
 

Geometry Expressions will make calculations in the geometry based on any constraints 
or constructions you have specified, or just from the sketch.  Calculations can be output 
in Real or Symbolic terms by choosing the appropriate tab.   

If you haven’t supplied all of the necessary input constraints, the system inserts any 
missing variables automatically or, for real calculations, bases the value on the sketch.   

Some calculations may take longer than you expected.  If the calculation isn’t 
immediate, you can stop it and restart it with these buttons on the tool bar. 

 Stops calculations 

 Restarts calculations. 
 

You may want to reconsider the problem, add constraints, or just let it continue with the 
calculation. 

The table below lists all the available calculations and geometry elements which must 
be preselected.  Be careful when selecting geometry objects, if extra things are selected 
that are not related to the calculation (like other calculations) the calculations will remain 
inactive.  This can happen by mistake, especially when using the selection box tool. 

 Calculation Preselected Object(s) 

  Distance / 
Length  

A line segment, vector, or polygon side, or a point and 
one of these line types (perpendicular distance), or 
two points. 

  Radius  Circle 

  Angle  Two of any line, segment, vector, or polygon side. 

  Direction  A line, segment, vector, or polygon side. 

  Slope  A line, segment, vector, or polygon side. 

  Coordinates  Point 

  Area  Circle or polygon 
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  Perimeter  Circle or polygon 

  Coefficients  Vector 

  Parametric 
Equation  

A line, segment, vector, polygon side, circle, or a 
constructed locus.  

  Implicit Equation  A line, segment, vector, polygon side, circle, or a 
constructed locus. 

Distance / Length Calculation 

 
 

Length calculations may be obtained for any line segment, polygon side or vector.  
Distance calculations are available between two points, or the perpendicular distance 
between a point and a line, segment, polygon side, or vector.   Use these steps: 

1. Select  the line segment, or point and line, or pair of points as described 
above. 

2. Click the tab to switch from Real to Symbolic output or vice versa. 

3. Click the Distance / Length tool in the Calculate toolbox or select Distance / 
Length from the Calculate menu. 

 

Geometry Expressions displays the length, using any relevant parameters you may 
have specified.  

Radius Calculation 

 
 

Geometry Expressions will calculate the radius of any circle.  Use these steps to find the 
radius: 
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1. Select  a circle. 

2. Click the tab to switch from Real to Symbolic output or vice versa.   

3. Click the Radius tool in the Calculate toolbox or select Radius from the Calculate 
menu. 

 

The equation with real or symbolic terms appears in the diagram. 

Angle Calculation 

 
 

Geometry Expressions will calculate any angle between lines in the geometry.  Use 
these steps to find the angle: 

1. Select  two line types. 

2. Click the tab to switch from Real to Symbolic output or vice versa.   

3. Click the Angle tool in the Calculate toolbox or select Angle from the Calculate 
menu. 

The equation with real or symbolic terms appears in the diagram. 

You can obtain the angle’s supplement by dragging the angle symbol. 

Supplementary Angles 

If it’s unclear whether a calculation is requested for the angle or its supplement, you can 
drag the angle symbol to the correct position.   
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Here are some examples of playing around with supplementary angles, both inputs and 
outputs:  

 

 

Direction Calculation 
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Geometry Expressions will calculate the direction of lines, segments, polygon sides, or 
vectors with these steps: 

1. Select  a line type. 

2. Click the tab to switch from Real to Symbolic output or vice versa.   

3. Click the Direction tool in the Calculate toolbox or select Direction from the 
Calculate menu. 

The direction measurement appears in real or symbolic terms.  

Slope Calculation 

 
 

Geometry Expressions will calculate the slope of lines, segments, polygon sides, or 
vectors with these steps: 

1. Select  a line type. 

2. Click the tab to switch from Real to Symbolic output or vice versa.   

3. Click the Slope tool in the Calculate toolbox or select Slope from the Calculate 
menu. 

The equation for the slope with real or symbolic terms appears in the diagram. 

Calculate Coordinates 

 
 

You can calculate the coordinates of any point in your diagram with these steps: 

1. Select  a point. 

2. Click the tab to switch from Real to Symbolic output or vice versa.   
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3. Click the Coordinates tool in the Calculate toolbox or select Coordinates from 
the Calculate menu. 

The real or symbolic coordinates appear by the point. 

Area Calculation 

 
 

You can obtain the area of any polygon or circle in your diagram. 

Note:  If your polygon is not filled it is just a group of line segments.  To convert them to 
a polygon, use the Polygon Construction tool, then proceed with these steps: 

1. Select  a circle or polygon. 

2. Click the tab to switch from Real to Symbolic output or vice versa.   

3. Click the Area tool in the Calculate toolbox or select Area from the Calculate 
menu. 

The area is displayed in real or symbolic terms. 

Perimeter Calculation 

 
 

You can obtain the perimeter of any polygon or circle in your diagram. 

Note:  If your polygon is not filled it is just a group of line segments.  To convert them to 
a polygon, use the Polygon Construction tool, then proceed with these steps: 

1. Select  a circle or polygon. 

2. Click the tab to switch from Real to Symbolic output or vice versa.   

3. Click the Perimeter tool in the Calculate toolbox or select Perimeter from the 
Calculate menu. 
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The perimeter is displayed in real or symbolic terms. 

Calculate Coefficients 

 
 

Use this tool to calculate the coefficients of a vector in the diagram with these steps: 

1. Select  a vector. 

2. Click the tab to switch from Real to Symbolic output or vice versa.   

3. Click the Coefficients tool in the Calculate toolbox or select Coefficients from 
the Calculate menu. 

The real or symbolic coefficients appear by the point. 

Calculating Parametric Equations 

 
 

Computes parametric equations for a locus or envelope, based on the parameter 
defining the curve. 

You can also calculate parametric equations for a circle or line. 

Use these steps: 

1. Select  any geometry object described above. 

2. Click the tab to switch from Real to Symbolic output or vice versa.   

3. Click the Parametric Equation tool in the Calculate toolbox or select Parametric 
Equation from the Calculate menu. 

The real or symbolic equations for x and y appear by the geometry. 
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Calculating Implicit Equations 

 
 

Calculates the implicit equation for the selected circle or a line. 

Geometry Expressions will also attempt to calculate the equation of a locus or envelope 
curve. 

1. Select  any geometry object described above. 

2. Click the tab to switch from Real to Symbolic output or vice versa.   

3. Click the Implicit Equation tool in the Calculate toolbox or select Implicit 
Equation from the Calculate menu. 

The real or symbolic equation appears by the geometry. 
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Viewing the Output  

 
 

The Output tools apply to Symbolic Calculations. 

After you have made a calculation, click the resulting output, either in the drawing 
window or the output window.  This will highlight entries in the Output tool box to refine 
your calculation. 

The Output check boxes specify how the calculations are made and how the output is 
displayed.   

• Use Assumptions – applies to equations containing absolute values. 

• Use Intermediate Variables – can sometimes simplify the output. 

The "Show" check boxes control where the output is displayed. 

Click a check box to show (when checked) or not show (when not checked).  

Intermediate Variables 

Substituting intermediate variables can sometimes simplify expressions calculated by 
the program.  Try this option to see how it affects your output: 

1. Select  an output calculation. 

2. Click the Use Intermediate Variables check box. 

3. Click the box again to change back to the previous form. 

If Use Intermediate Variables is not checked, the Show Intermediate Variables is 
inactive. 

Note:  Intermediate variables are not always used in calculations, in which case this box 
will have no effect. 
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Assumptions 

With the Use Assumptions check box, Geometry Expressions eliminates the absolute 
value from expressions and determines from the diagram whether the value is positive 
or negative.  Try it with these steps: 

1. Select  an output calculation. 

2. Click the Use Assumptions check box. 

3. Click the box again to change back to the previous form. 

Obviously, this tool only has an effect when the expression selected contains an 
absolute value. 

Show Output Check Boxes 

 
 

After you generate an output expression:  

1. click the output  

2. click one or more of the Output Show. . . check boxes to apply them to the 
selected expression 

• Show Intermediate Variables – if the system uses intermediate variables, their 
definitions are displayed in the output window. 

• Show Name – is a term assigned by the system to the output. 
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• Show On Diagram – puts the output expression on the diagram when 
checked. 

• Show in Output Window – puts the output expression in the Output Window 
when checked. 

• Too Big for Diagram – indicates when the output expression is too big for the 
diagram window, according to the setting of the slider below. 

 

Maximum Size Allowed On Diagram – slider sets the threshold for the size of 
expression for all output that appears on the diagram.   

Setting the slider to the extreme left (Small) gives the same result as unchecking the 
Show on Diagram box and will not place the output in the Diagram Window. 

Setting the slider to the extreme right (Large) will always show the output in the 
Diagram Window. 

 



Geometry Expressions Manual 

— page 115 — 

The Symbols Toolbox 

 
 

The Symbols toolbox lets you easily insert Greek letters into your expressions and 
constraints.  Click the tab to choose from lower case or upper case Greek letters. 

The bottom row of buttons in the toolbox lets you insert commonly used math 
operations. 

Inserting Greek Letters 

To insert Greek letters into any variable name or expression, click the appropriate tab, 
Greek Upper (upper case letters) or Greek Lower ( lower case letters), and click the 
letters to be inserted into the data entry box. 

 

Multiplication and Division Editing Tools 

The Multiplication button inserts a multiplication symbol into the expression. 

 The Division button makes expressions easier to enter and read.   

♦ From the data entry box, enter the numerator of the expression, highlight it, 

and then click Division.    

The cursor is then positioned in the denominator. 

♦ If you click the Division button first, be sure to place the cursor in the 
appropriate place before typing the expression. 
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Square Root Editing Tool 

 You can enter square roots in one of two ways: 

From the data entry box, enter the expression you want inside the square root, highlight 
the terms, and click the Square Root button. 

From the data entry box, click the Square Root button, then highlight the 0 and type the 
terms. 

Subscript / Superscript Editor 

You can enter superscripts or subscripts for variables in one of these ways: 

From the data entry box, enter the expression you want sub/superscripted, highlight the 
terms and click the Subscript  or Superscript  button.  

  

♦  From the data entry box, click the Sub/Superscript button and type the values 
into the grey boxes.  

  
Note:  Make sure the cursor is positioned at the left side of the gray box before 
typing the sub/superscript. 

♦ Another way to make a subscript is to use square brackets – 

A[1] = A1 

Parentheses and Absolute Value Notation 

You can add parentheses or an absolute value sign to a term in one of two ways: 

From the data input box, type the term(s), highlight it, then click the Parentheses  or 

Absolute Value  button.   

From the data entry box, click the Parentheses  or Absolute Value  button and 
enter the terms. 
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The Variables Toolbox 

 
 

The Variables toolbox reports all the variables you have used in the diagram and lets 
you manipulate their values. 

For details on the sections of the toolbox. See: 

♦ Variables list box (p. 118) 

♦ Variable edit window (p. 119) 

♦ Animation console (p. 120) 

♦ Animation mode buttons (p. 121) 

♦ Animation values and duration (p. 121)   
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Variable List 

 
 

This list contains the names of all variables used in your diagram. 

For every variable name, the system shows: 

♦ the current value – these values can be ones that you have explicitly specified, or 
just taken from the way you sketched the geometry. 

♦ lock status – if the variable is locked (+) its value will not change if you move the 
geometry or add additional constraints;  the unlocked (-) variable is free to change 
as the geometry moves or changes. 

Using the Lock Tool 

By default, when you drag points in a Geometry Expressions model, it will adjust the 
numerical sample values used in the various parameters of the model to accommodate 
the drag, as best it can. 

For example, in the model of a 4 bar linkage below, dragging point B will cause lengths 

a and b and angle θ to be adjusted appropriately.   

 
However, you may want the drag to act as if the members AB and BC were rigid, and 
only angle theta adjustable.  To do this you can lock parameters for dragging: 
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The value of a, for example, can still be set from the Variables panel, but it will not 
change when the model is dragged. 

Changing and Locking the Variable Value 

 
 

To make a change to the variable list, first click anyplace in the row of the variable you 
want to change.  That row will be highlighted. 

To change the value:  highlight the value in the edit window and type the new value. 

To change the lock status:  just click the button – 

  to unlock a locked variable 

  to lock an open variable 
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Animation 

Your geometry comes to life with the Animation tools.  You simply need to select the 
parameter that drives the animation, give it a range, then Play. 

In the diagram below we select θ for the crank of this linkage. 

 
 

Users of numeric interactive geometry systems may be familiar with the concept of 
animation based on points animated along line segments or curves.  This type of 
animation can be conveniently modeled in Geometry Expressions using the point 
proportional along a curve constraint along with parameter based animation. 

Animation Console 

  The Animation console works like a standard video console with the 
Play, Pause, and Stop buttons as well as advance to the Beginning and End buttons. 
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Animation Modes 

  The animation modes can be changed with the up/down arrow  
buttons.  The modes are: 

 Runs the animation one time through the specified range. 

 Runs the animation continuously from the beginning to the end of the 
range.  

 Runs the animation one time forward and then backward through the 
specified range. 

 Runs the animation continuously forward and then backward through the 
specified range. 

Animation Values and Duration 

   
 

These animation buttons help you adjust the range and speed of the animation. 

Click and drag the slider along the bar to manually animate the drawing. 

In the two data entry windows at the bottom right and left of the toolbox, specify the 
range of the animation. 

The Duration box in the center lets you specify how long the animation takes to play 
one time through.  Values are between 1 and 60 seconds. 

Animation and the Locus Tool 

Both the construction of the locus and envelope curves, and the animation of the 
diagram in Geometry Expressions can be defined in terms of any variable.  For example 
in the model below, we can create a locus over values of the variable t (other variables 
will be kept constant). 
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File Menu 

The File menu contains the standard Windows file handling operations with options for 
copying and exporting to other programs.  Several of the options are also available from 
the icon bar. 

Menu Option Function 

 New 
Creates a new project. 

 Open. . . 
Brings up the Open File dialog box so you can open a project. 

Close Closes the current file or, if multiple files are open, the file on 
top 

 Save 
Saves the file.  If you have not yet saved the current work to a 
file,  the Save File As dialog box lets you specify where to 
save the project file. 

Save As . . . Brings up the Save File As dialog box so you can specify 
where to save the project file or change the file name 

Export  Export the file as Windows Metafile (.emf) or an image file 

Page Setup. . . Displays the page set-up dialog box for choosing a printer and 
print options 

 Print Preview 
Displays the printout by pages  

 Print. . .  
Displays the standard system Print dialog 

Recent files Click to display a list of the most recently used files.  Selecting 
one opens it. 

Exit Exits the program, after prompting for save 
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Exporting a Drawing 

To export your drawing to another program, choose 

File > Export.  You can export the drawing as a Windows Enhanced Metafile or in one 
of several standard image formats. 

File > Export > Image File displays the Image Export dialog.  

 
 

•  Click the right hand arrow  to select one of the following formats: 

.bmp   .jpg 

.tiff   .png 

.xpm 

• Set the resolution in the File DPI box - click the down arrow and select the 
appropriate setting, or enter a custom setting. 

• Enter the Filename or click the folder icon to select the appropriate folder and file. 

• Click OK to save or Cancel to abort the save. 
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Edit Menu 

The Edit menu contains the standard Windows editing operations as well as ways of 
dealing with constraint conflicts and all of the program settings.  Several of the options 
are also available from the icon bar. 

Menu Option Function When Available 

 Undo  
Reverses actions starting with the 
last one. 

After any action has been 
taken. 

 Redo  
Reinstates actions starting with the 
last one that was undone. 

After using Undo 

 Select 
When checked, the select mode is 
active 

Select mode is always 
active except when using a 
Drawing tool or moving or 
panning the drawing. 

Select All Selects everything in the drawing 
window  

Always 

 Cut  
Deletes an object, but saves it so it 
can be pasted somewhere else. 

An object is selected 

 Copy 
Does not delete the object, but 
saves is so it can be pasted 
somewhere else. 

An object is selected 

Copy As Displays a submenu of choices for 
copying mathematics into other 
programs 

An expression or formula is 
selected 

Copy Drawing Copies everything in the drawing 
window as an Enhanced Metafile 
(.emf) 

Always 

 Paste  
Puts whatever has been cut or 
copied into the current document 

Object(s) cut or copied 

Delete  Deletes whatever is selected, 
without saving it. 

One or more object(s) 
selected 

Convert to 
Constraint 

Tries to convert a selected output 

[⇒2θ] to an input constraint if there 
is no conflict with other constraints 

An output expression is 
selected 

Convert to 
Measurement 

Converts the selected constraint 
into a measurement (output) 

An input constraint is 
selected 

Properties. . . Lets you edit the display properties 
of the selected object(s) 

One or more objects of the 
same type are selected 
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Settings. . . Sets the default appearance and 
properties for the project’s drawing, 
text and mathematics 

Always 

Adjusting the Drawing’s Default Settings 

The default settings are grouped by type, listed on the left side of the Settings dialog.   

 
 

- set the line color and style for each selection type.   
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- set font related properties for labels; color and size / style for other 
geometric elements. 

- set font properties and the Pinned state.  Pinned Text can not be moved 
relative to the Page Boundaries. 

- set the properties for alpha-numeric input and output; mathematical 
calculation defaults 

 - set properties of the Major and Minor Grid, the coordinate Axes, and 
the Page Boundary lines.  

 

To see the possible values for each property, click the row.  An icon will appear at the 
right end of the row (except the Point Size selection under the Font property – you can 

enter the point size directly).  Click the icon to display the selection dialog  or 

drop-down menu of choices . 

 

Changing a default for a type of drawing entity will apply to all entities of that type 
except ones whose properties have been individually set, by selecting it and then 
choosing Edit > Properties or right clicking Properties from the context menu.  Also, 

text or expressions that were individually pinned   or unpinned  will 
not be affected by changes to the default Pinned settings. 
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View Menu 

The View menu has Zoom operations pertaining to the screen view, and Scale 
operations pertaining to the page view.  

The table below lists the complete summary of View functions. 

Menu Option Function When Available 

Hide Hides a selection One or more element(s) are 
selected. 

Show all Displays any entities that were 
hidden 

One or more element(s) are 
hidden. 

Zoom In Makes the drawing details larger 
without affecting the size on the 
printed page. (The text gets larger 
on the screen.) 

Always available – (most 
useful when there is 
something in the drawing 
window). 

Zoom Out Makes the drawing details smaller 
without affecting the size on the 
printed page. (The text gets smaller 
on the screen.) 

Always available – (most 
useful when there is 
something in the drawing 
window). 

Zoom To 
Selection 

Lets you make a selection and 
adjusts it to fit the drawing window.  
(The text gets larger on the screen.) 

Always available – (most 
useful when there is 
something in the drawing 
window). 

Zoom To Fit The entire diagram is displayed in 
the drawing window.  (The text size 
changes with the geometry.) 

Always available – (most 
useful when there is 
something in the drawing 
window). 

Zoom To Page The whole page is displayed in the 
drawing window.  (The text size 
changes with the geometry.) 

Always available – (most 
useful when there is 
something in the drawing 
window). 

Pan View Allows you to move the contents of 
the drawing window without 
changing its position on the page. 

Always available – (most 
useful when there is 
something in the drawing 
window).   

Scale Geometry 
Up 

Enlarges only the geometry.  (The 
text size on the screen doesn’t 
change.) 

Always 

Scale Geometry 
Down 

Shrinks only the geometry.  (The 
text size on the screen doesn’t 
change.) 

Always 
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Scale Geometry 
To Selection 

Lets you select a portion of the 
geometry and adjusts it to fit the 
drawing window (The text size on 
the screen doesn’t change.) 

Always 

Scale Geometry 
To Fit 

Adjusts all geometry to fit in the 
drawing window.  (The text size on 
the screen doesn’t change.) 

Always 

Scale Geometry 
To Page 

Adjusts all geometry to fit inside the 
specified page boundaries. (The 
text size doesn’t change relative to 
the page.) 

Always 

Move Geometry When checked, click and drag to 
move the drawing contents with 
respect to the page boundaries. 

Always.  (Make sure Page 
Boundaries is checked to see 
the results.) 

Axes When checked, the axes are 
displayed.   

Always 

Grid When checked, the grid is 
displayed. 

Always 

Page 
Boundaries 

When checked, the page 
boundaries are displayed. 

Always 

Tools When checked, the toolboxes are 
displayed to the side of the drawing 
window. 

Always 

Output When checked, the output window 
is displayed. 

Always 

 

Checked menu options are toggles:   

• Checked indicates the option / mode is active or displayed. 

• Unchecked indicates the option / mode is inactive or hidden. 
 

Click the selection to change its state. 
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Toolbox Menus 

The menus with the same name as the toolboxes at the side of the screen just give 
another way of accessing the same functions. 

Menu Option Selection   

Draw  Point  Vector  Text  

 Line Segment  Polygon  Expression  

 Infinite Line  Circle   

Constrain  Distance / Length  Direction  Tangent  

 Radius  Slope  Incident  

 Perpendicular  Coordinate  Congruent  

 Angle  Coefficients  Parallel  

 Equation  Proportional   

Construct  Midpoint  Parallel  Reflection  

 Intersection  Perpendicular  Translation  

 Perpendicular Bisector  Tangent to Curve  Rotation  

 Angle Bisector  Polygon  Dilation  

 Locus    

Calculate  Distance / Length  Coordinates  Slope  

 Direction  Coefficients  Angle  

 Radius  Area  Perimeter  
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Help Menu 

The Help menu lets you access the help system, check for updates, change the 
program’s language, and gives you information about the program’s license and 
version.  The menu selections are always available. 

Menu Option Function 

Dynamic Help Invokes the Help system 

Contents. . . Look in the Table of Contents; add new or refer to saved bookmarks. 

Index. . . Look in the Help index.  There is also a facility to Search index 
headings. 

Search. . . Search the Help topics for keywords. 

Language The current version of Geometry Expressions can be displayed in 
English, French, German, or Spanish.  Choose one and restart the 
program. 

License. . . Displays information about your license. 

Check for 
Updates. . . 

Prompts you to save your work, checks for new versions of 
Geometry Expressions, then restarts the program. 

About. . . Contains the current version of the program, the copyright notice, 
and the link to Geometry Expressions’ website. 
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Context Menus 

Context Menus pop up when you right-click with the cursor positioned anywhere in the 
drawing window.   

♦ The general context menu – appears when you right click and nothing is 
selected. 

♦ The selection context menu – appears when one or more elements in the 
drawing window are selected.  Some menu entries my be inactive, depending on 
which elements are selected. 

The General Context Menu 

Right-click anywhere in the Drawing Window to display a context menu.  If nothing in 
the window is selected, the menu choices are the following: 

Menu Option Function When Available 

[file name] Displays the name of the current file.  
If you have not specified one, the 
default is displayed – "unnamedX". 

Always 

Close Closes the current file Always 

Save Updates a file that already exists The file has been saved  

Save As. . .  Saves a file for the first time and 
prompt for the filename and path 

Always 

Select All Selects everything in the drawing 
window 

Always 

Copy Drawing Copies everything in the drawing 
window as an  Enhanced Metafile 
(.emf)  

Always 

Paste Puts whatever has been cut or 
copied into the current document  

Object(s) cut or copied  

Show All Displays any entities that were 
hidden  

One or more element(s) are 
hidden  
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Selection Context Menu 
 

Menu Option Function When Available 

Selection Indicates an item is selected Always 

Cut Deletes an object, but saves it so it 
can be pasted somewhere else.  

An object is selected 

Copy Does not delete the object, but 
saves is so it can be pasted 
somewhere else.  

An object is selected  

Copy As Displays a submenu of choices for 
copying mathematics into other 
programs  

An expression or formula is 
selected 

Paste Puts whatever has been cut or 
copied into the current document  

Object(s) cut or copied 

Delete Deletes whatever is selected, 
without saving it. 

One or more object(s) 
selected 

Constrain 
(Input) 

Displays a submenu identical to the 
one in the same drop-down menu on 
the Menu Bar 

A geometry object is 
selected 

Construct Displays a submenu identical to the 
one in the same drop-down menu on 
the Menu Bar 

A geometry object is 
selected 

Calculate 
(Output) 

Displays a submenu identical to the 
one in the same drop-down menu on 
the Menu Bar 

A geometry object is 
selected 

Hide Hides one or more selections One or more object(s) 
selected 

Properties. . . Lets you edit the display properties 
of the selected object(s) 

One or several similar 
objects are selected 

[Convert to 
Calculation 
(Output)] 

Deletes the selected constraint and 
calculates the equivalent output  

Only displayed when a 
constraint is selected 

[Convert to 
Constraint 
(Input)] 

Changes the calculation to an input 
constraint 

Only displayed when an 
output expression is selected 
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